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READ ME FIRST
INTRODUCTION
This guide was developed to assist CerTest program managers and computer
administrators migrate from CerTest 4.x to CerTest 5.0. This guidance is also

applicable for those establishing a CerTest program where none existed previously.

Welcome to the next generation of Civil Engineer skill certification and testing—CerTest
5.0. To begin the upgrade process, you’ll need to acquire a version of 5.0.

To acquire your version of CerTest 5.0, you have the following options:

» Utilize the CerTest 5.0 disk from your local Fire Protection Flight

» Email — If you send an email to scottie.spradlin@tyndall.af.mil or
iim.lucas@tyndall.af.mil you will be sent 23 separate emails each containing a 5-

megabyte chunk of the entire CerTest 5.0 program. You will receive directions
on how to assemble the pieces for use.

» Wait for your copy to arrive in the mail—ETA January 2004

Obviously, the most practical and recommend method is to obtain a copy from your
local fire protection training manager.

This CerTest upgrade will be unlike previous version updates. After testing the various
upgrade options, it has been decided that the best method for the CE Ops community is
to install 5.0 independently from previous 4.x installations. Basically, you’ll be starting
fresh with 5.0. The decision to take this particular route was based on the instability
displayed by the program when updated over the top of the previous version. This
option will put some additional burdens on unit program managers initially, but the extra
work up front will pay off in less system problems in the long-term.

Please take the time to scan this document and the installation guidance before
proceeding. The degree to which you follow these instructions will determine the
stability and ease of use of your new 5.0 installation. As always, if you have questions
or suggestions on how we can improve this program, don’t hesitate to contact the HQ
AFCESA CerTest managers listed in this document.

For technical support contact: MSgt Scottie Spradlin DSN 523-6373 or
SMSgt Jim Lucas DSN 523-6380


mailto:Scottie.sparadlin@tyndall.af.mil
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CERTEST 5.0 INSTALLATION INSTRUCTIONS

HOW TO UPGRADE FROM A PREVIOUS VERSION OF CERTEST

As stated previously, you will not be upgrading your existing version of CerTest.
Rather, you'll be installing 5.0 to a new directory, either on the network or a standalone
computer. You will be keeping your current CerTest version, with a few modifications,
for historical purposes. We have taken this route in an effort to eliminate many of the
error messages associated with the previous CerTest versions. Don’t hesitate to call if
you have questions concerning the procedure outlined below.

STEP 1 -- TAKING YOUR CURRENT CERTEST VERSION OUT OF SERVICE
Before starting this step and if possible, please make backups of all student data.
Note: The student data will not be compatible with your new 5.0 installation, but can be

retrieved via your old CerTest version or through AFCESA’s master system.

Locate the directory where your current version of CerTest resides. It will be a
networked drive for LAN installations or the C/D drive for standalone configurations.
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Rename the directory “Certest 4.x.” This will isolate the directory from further
access by the CerTest icon on client machines or the standalone computer. In the
event you need to retrieve old CerTest data, you will run the certest.exe file located in

the CerTest 4.x directory.
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Now, you’ll need to remove any Certest shortcut icons on the desktop and the CerTest folder
from the Windows start/program menu. CerTest does not have an uninstall feature, so

will need to remove all shortcuts and start menu items by deleting them. You can
accomplish this by right clicking on the item and selecting delete. Do this for all CerTest

references except for the “CerTest 4.x” folder you renamed previously.

Once accomplished, you have a clean canvas in which to install CerTest 5.0.

STEP 2 — INSTALLING CERTEST 5.0

» Insert the CerTest 5.0 CD into the CD-ROM drive.

» From the Windows Start menu, select Run.

» In the "Run" dialog box type: D:\SETUP where D: is the drive letter of the CD-

ROM drive.



Click OK to continue. If D:\ is not the drive letter of the CD-ROM drive, you will
need to change the drive letter to represent your CD-ROM drive.

The CerTest logo will appear behind a box welcoming you to the CerTest
installation. Select Next to continue.

The Installation Program will search the computer for Adobe Acrobat. If it does
not find a version of Acrobat, you will be given the option to install the Adobe
Acrobat Reader. This will allow you to view the Fire Protection Procedural
Guide, the Operations Management Guide, the How Do |I? Guide, and the CFC &
HCFC Study Guide.

Some files will be copied to your WINDOWS\SYSTEM directory.

You will now be asked where the CerTest icons should be added. By default, the
CerTest icons will be added to a CerTest folder in the Programs section of the
Windows Start Menu. You may select any existing folder in the Programs
section of the Start Menu, or type a new folder name. Select Next to add the
CerTest icons to the selected Programs folder.

You will now be asked if you wish to view/print this README.TXT document. If
you select Yes, this file will be opened with Microsoft Notepad. You must close
Notepad (use the Exit option under the File menu) before the Installation
Program will continue.

The Installation Program will search all the drives on your computer and compile
a list of prior versions of CerTest.

If you have any network drives attached to your computer, you will be asked
whether to search them for prior versions of CerTest. If you have a prior CerTest
version installed on your network, click Yes.

If the Installation Program finds one or more previous Windows versions of
CerTest, only these will appear in the list. You may only upgrade ONE of these
previous Windows versions. Click on the version you wish to upgrade, and then
click OK.

A box will appear asking for the directory to install to.

If you wish to install on a stand-alone computer (one that WILL NOT run CerTest
on a network), then select a directory on the hard drive of that computer. It is
suggested that you select C:\CERTEST (the default directory).

If you wish to install on a network (so that all tests and student data are stored on
the network), then select a directory on the appropriate network drive.



» To install to a network, you must run the CerTest CD-ROM Setup.exe from a
workstation that has the network connected as a network drive. DO NOT run the
CD-ROM Setup.exe program on the network server itself.

» You will now be asked to verify your choice of network or stand-alone
configuration. By choosing Cancel you can re-enter the installation directory.

» Select the CerTest test bank(s) to install.
» Now decide how to set up your CerTest system.

» CerTest can be set up to run off of the hard drive, from a local area network
(preferred), or from the CD. When running CerTest from the CD, however, you
will need a CD for each computer in use in order to take a test. If you have more
than one computer, you can download CerTest to some machines and run
CerTest from CD on others.

» The Installation Program will copy the appropriate files to your computer and
upgrade your tests and student records if necessary.

» On the Item Analysis Configuration screen, enter the name of your site and an
identifier for your computer (i.e., Tyndall AFB, Computer 1 or Sheppard AFB,
Training office). This will need to be done once for each machine where CerTest
is loaded on the hard drive or only once for a network installation (and not at all if
upgrading a previous version of CerTest).

» If you are installing the network version, files necessary to setup additional
CerTest workstations will be copied to the network. The installation program will
display a final message giving the location of the network SETUP program.

STEP 3 — INSTALLING ADDITIONAL CERTEST WORKSTATIONS ON A NETWORK
INSTALLATION OF CERTEST

» If you have installed CerTest on a network, you will need to set up any
additional workstations (computers other than the one you installed from) that
will run CerTest from the network.

» The Workstation SETUP Program copies the files necessary to run CerTest
from the network and creates the CerTest icons on the Windows Start Menu.



» From the Windows Start menu, select Run.
» In the "Run" dialog box type:
N:\CERTEST\SETUP\SETUP.EXE
Where N:\CERTEST is the network drive and folder where CerTest
5.0 has been installed. If N:\ is not the drive letter of your network,
you will need to change the drive letter to represent your network

drive.

» The CerTest logo will appear behind a box welcoming you to the CerTest
Workstation Setup. Select Next to continue.

» The Installation Program will search the workstation for Adobe Acrobat. If it
does not find a version of Acrobat, you will be given the option to install the
Adobe Acrobat Reader. This will allow users to view the Fire Protection
Procedural Guide, the Operations Management Guide, the How Do 1? Guide,
and the CFC & HCFC Study Guide on the workstation.

» Some files will be copied to your WINDOWS\SYSTEM directory.

» The Installation Program will copy the appropriate files to the workstation.

» You will now be asked where the CerTest icons should be added. By default,
the CerTest icons will be added to a CerTest folder in the Programs section of
the Windows Start Menu. You may select any existing folder in the Programs
section of the Start Menu, or type a new folder name. Select Next to add the
CerTest icons to the selected Programs folder.

STEP 4 — STARTING YOUR NEW 5.0 INSTALLATION
» From the Windows Start menu select the CerTest icon.
» Click on the CerTest title screen to get to the log-on screen.
» You will initially log-on as Sir Test, type:
Social Security Number: 123-45-6789
Password: CE
» Log into CerTest as Sir Test.

» Add yourself as a manager.



» Exit CerTest.
» Log into CerTest as yourself (or your new manager).

» Remove Sir Test.

WARNING: To protect the CerTest system, delete Sir Test from your system.

You should now have your server and workstations configured and ready to embark on
the next generation of Civil Engineer certification and testing. Again, do not hesitate to
call if you have any questions concerning this upgrade process.
WHAT'S NEW SINCE CERTEST VERSION 4.0
The following changes have been made in CerTest version 5.0:
» After finishing a test, students may now review the questions that they missed.
» Question challenges are now downloaded as .CHL files (instead of .TXT files).
» Questions may now include underlined, italicized, and highlighted text.
» A spelling checker has been added to the test editor.
» A search (find) feature has been added to the test editor.
» A utility for importing UO files has been added.
» Questions may now include underlined, italicized, and highlighted text.
» The Test Specs window now includes the test version date.
» Three new math symbols have been added to the CerTest test font.
» The Fire Protection Procedural Guide, Operations Management Guide, How Do
|7 Guide, and CFC & HCFC Study Guide have been converted from MS Word
documents to Adobe Acrobat documents.

The following problems have been fixed in CerTest 5.0:

» Compression Error -7, "No Files Found" when copying students or test to/from a
networked version of CerTest.



» Test locks up the computer when Bookmark selected.

» Error when copying students/tests on a computer that does not have an A: drive.
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CERTIFICATION AND TESTING PROGRAM

MANAGEMENT GUIDE

This guide outlines the policy and procedures for the CerTest program as it applies to program
management and use for the Civil Engineer Operational AFSCs.

NOTE: For purposes of this guide, the Operational AFSs include all CE AFSCs except Fire
Protection (3E7X1). For additional information on the Fire Protection CerTest procedures see
the Fire Procedural Guide.

All informational documentation (guides) and help for the Windows® version of CerTest is now
on-line. If you’re not sure how to do something in this version of CerTest once it’s installed on
your computer, use the Help pull-down menu to receive information or instructions on the topic
you need help with. The informational guides are also available for download at the HQ
AFCESA website _http://www.afcesa.af.mil.

The CerTest Management Guide for Operational AFSs may be accessed from the Help menu.
This Guide, as with the two other available guides, can be viewed on-line or printed locally.
Each UETM should print a complete copy of this document to use a handy reference. All
CerTest program managers (test proctors) are responsible for adhering to the guidelines in this
Management Guide.

1. General Information: CerTest is an interactive computer-based program designed to test,
evaluate, and certify a student’s knowledge of principles and procedures on various job-related
subjects. CerTest is not a study tool, and should not be used for any other purpose than
verification of prior learning. The CerTest program contains numerous tests used to evaluate
subject and task knowledge. Completion of some of these tests is mandatory for upgrade
while others are not.

a. ALL tasks identified with a diamond (L) in the Career Field Education and Training
Plan (CFETP) has an Air Force Qualification Training Package (AFQTP) with a corresponding
Mandatory CerTest. Completion of all applicable CerTests is mandatory to meet upgrade
requirements. As of the publication of this guide there are approximately 80 mandatory
CerTests relating to diamond tasks in the CE community.

b. CerTest was used extensively during the CE AFSC mergers of the early 90’s.
Approximately 300 Certests facilitated this merger; however, the days of the “CerTest Video
Tape Libraries” are over. Many of the videotapes and corresponding CerTests related to the
mergers are still relevant and serve as an excellent source for supplemental AFS training.
Completion of these CerTests is not mandatory.

c. Career Development Course (CDC) volume review exercises (VREs) and end of
course (EOC) evaluations tools (approximately 115 tests) have been added to CerTest. These
Certests are used to evaluate the trainee’s preparedness prior to taking the EOC. Units that
have used these evaluation tools have shown a dramatic decrease in CDC failures. We
strongly encourage their use. Completion of these CerTests is not mandatory. NOTE: Some
squadron operating procedures call for passing score on these evaluations before they are
allowed to test.
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d. All CerTests basically come under one of three categories, each with different levels
of access authority. The access categories are as follows:

1) Unlocked CerTests. Approximately 12 tests in the program are identified as “Pre
tests” and can be taken by anyone with a valid logon as many times as desired.

2) Locked CerTests. The majority of CerTests fall into this category. The Test
cannot be taken until the CerTest Program Manager unlocks the test for an
individual. The individual has a maximum of 4 attempts to pass the test.

3) Code-enabled CerTests. Cannot be opened by the UETM until an enable code
is entered. These tests normally involve national certification issues. An
example is the CFC CerTests. The applicable authority issues the codes. (see
pages 6, 9)

2. CertTest Management: The CerTest program may be managed in different ways. It may be
set up on one stand-alone computer system, or set up on a series of centrally located “stand-
alone” computers (such as the Learning Resource Center [LRC]), or place on a drive/network
system. Each method has its own advantages and disadvantages. Select the one that works
best for you and your unit. If installed on more than one computer; however, computers must
be located so that one of the three CerTest managers (withy lock/unlock privileges) can control
(proctor) all testing. It is recommended that these computers be located in a centralized
Learning Resource Center (LRC). CerTest can be installed on computers that have other
programs loaded on the hard drive.

a. To maintain integrity, and prevent test compromise, each UETM can assign up to
three individuals as CerTest program managers with lock/unlock test privileges. The CerTest
program will not allow more than three with these privileges. The CerTest program should be
maintained like other official testing programs (See your service specific regulations for
requirements).

3. Specific CerTest Manager (UETM) Responsibilities: The following are specific
responsibilities for the CerTest Manager:

a. Load CerTest. Assign and load two more CerTest Managers with lock/unlock rights to
assist you.

b. Update CerTest via web downloads from www.afcesa.af.mil

c. Administer the CE Craftsman 7-Level Read-a-head (RAM) exam (No longer
required). Be sure to print a copy of the results for the individual to take to the in-
residence course with them.

d. Maintain the integrity of your program (follow Management Guide guidance

e. Ensure applicable CerTests are completed for all diamond tasks identified in the
CFETP

f. Administer and proctor test for trainees while testing (section 4 page 3)

g. Perform required program maintenance (section 5 page 3)

h. Add/Delete trainees due to PCS as necessary

Back-up student records and site-specific tests at least weekly
Collect and submit question challenges to the applicable DoD Administration Center as
equired. (Section 10 page 5)

_— =
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4. Test Proctor (any of the three managers with lock/unlock rights) Responsibilities: It is
the CerTest proctor’s responsibility to unlock and administer the applicable test, brief the trainee
on the test challenge feature, and place the test results in the trainees records.

a. Not only is a test proctor responsible for monitoring students taking all AF
Qualification Training Package (AFQTP), CFCs/HCFCs certification tests, CDC VRE and
EOC evaluation tests, he/she must also ensure these tests are not compromised in any way.
This means making sure students do not have access to reference materials during the test and
do not receive any assistance during the test. All “open book preparations” should be
completed prior to taking the CerTest. Ensure the trainee is given a reasonable amount of time
to complete a test.

WARNING: CerTest contains an “auto-shut-off” mode. After 5 minutes of inactivity, CerTest
will automatically score the test and exit. Whatever questions the student missed will be scored
as an incorrect response.

b. A CFC/HCFC proctor’s responsibility is so critical that each proctor is required to
complete the proctor authentication statement on each student’s record test summary to verify
that the proctor has complied with these and other guidelines contained in this Management
Guide. For more information on CFC Tests and proctor requirements see section 14 of page 6.

5. Program Maintenance and Security: To enhance program maintenance and most
importantly test security, several software changes were made. They are as follows:

a. CerTest 4.0 is shipped to each base in CD-ROM format only. The CerTest program
can be run either by local hard drive, or a local area network. After installation the CerTest CD-
ROM must be secured. If a program compromise is suspected, contact the any of the
three DoD POC(s) (see page 9).

b. Once you have loaded yourself as a CerTest manager using the master key “Sir
Test” (123-45-6789 CE log in), log on as yourself and delete “Sir Test” from the manager list.
Failing to delete Sir Test leaves your system subject to compromise.

c. Once CerTest is loaded it must be kept current. Check the AFCESA web site at
www.afcesa.af.mil monthly for CerTest Updates.

d. As stated earlier, the program allows up to three managers to have lock/unlock tests
rights. All other “managers” added (shop supervisors, supervisors, trainers) may be given rights
to, build shop tests (Site Specific Tests), and view student records.

6. Equipment and Material Required in Support the CerTest Program: Hardware and
software upgrade requirements for CerTest have remained at a conservative pace to maximize
participation. Commanders should be advised that CerTest is no longer an “optional” or
supplemental OJT system. Mandatory upgrade requirements (e.g. AFQTP tests, 7-Level
RAM test) have been tied to this platform. In the future CerTest will be the vehicle to
meet more mandatory requirements. Familiarization with CerTest will be critical for all
trainees enrolled in CDCs.

a. CerTest requires a minimum 486 PC (Pentium recommended) with at least 4
Megabytes (8 recommended) of Ram, MS-Windows® 3.1 (Windows '97
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recommended) or higher, a VGA/SVGA color monitor, and printer. The following hard
drive space must be available before installing CerTest:

Function Required Memory
To run tests from CD 6 Megabytes
To load CerTest Operations (CE Craftsman) 58 Megabytes
To load CerTest for Fire Protection/Readiness 26 Megabytes
To load Operations and Fire Protection/Readiness 73 Megabytes

b. Installation Strategy: If you currently do not have computer systems with a CD-
ROM drive, you can still load the program on each of your computer systems using an external
CD-ROM drive. Check with your local computer support section to see if they have one you can
use or make arrangements to purchase one or more. Also consider updating your computers

7. Learning Resource Centers (LRCs): The space and physical facilities selected for
computer-based testing must be conducive to continuous surveillance by a test proctor during
testing. Test proctors must ensure conditions are favorable for testing such as proper lighting,
temperature, and freedom from distractions. A centralized testing facility is recommended for
controlling the CerTest program. The test proctor must be able to monitor all computers at one
time while official (CFC/HCFC) testing is in progress. When an LRC is used for CerTest it will
be similar (with some exceptions) to requirements of a base test control facility (TCF).

8. Testing: The interactive computer portion of the program is used for testing only. CerTest
contains various tests: Pretests, Posttests, Demo tests, Site tests, AFQTP tests, CDC VRE and
EOC evaluations, etc. Open book testing, “practice-test-taking”, or test reviewing is
strictly prohibited. Personnel will not compromise any test by discussing or copying tests.

a. Students should be prepared to sit through a test until the test is completed. Once
testing has started, an entry must be made every five minutes; otherwise, the computer program
will terminate the test and the student’s score for the entire test will be recorded.

b. Once the student completes a test, the test summary screen should be printed and
placed into the student’s training record. If a student fails a test, a copy of the test summary
showing which areas of instruction require additional study should be given to the student.

NOTE: If a copy of the test summary is needed at a later date, it can be recalled by entering
into the Student Record and selecting the “Detail’ option under the View menu or by double
clicking on the Stat, Score, Date, or Attempts block for that test.

9. Test Failures Other Than CFC/HCFC: Test failure procedures should be addressed at the
unit level. There is no established number restricting the number of attempts an individual can
make at particular test; however, 2-plus consecutive failures should be brought to leadership’s
attention. The key point to keep in mind is that CerTest is an evaluation tool and not a training
tool. UETMs should be watchful of individuals taking tests repetitively in order to study the test.
For example: Amn Smith takes test 8175 and receives a score of 50. Obviously, Amn Smith
has not proficiently grasped the material and requires further training with his/her trainer.
UETMs should be mindful of their responsibilities in maintaining the integrity of the CerTest
program, as outlined in this guide.
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10. Statistical Data Collection: Each time a CerTest test is taken, the program automatically
collects statistical data that is used to validate the test. This information must be submitted to
the DoD Administration Center when requested. Each time the CerTest program manager
receives a “collect statistical data” message on the computer screen, or an e-mail request from
AFCESA, please complete the following:

To Collect Statistical Data: Select the “Statistical Data Utilities” option found in the File menu
of CerTest and follow the directions on the screen. Note: A separate disk must be used for
each computer.

11. Challenging a Question: Anyone may challenge a CerTest test question. While taking a
test, a student may find a question that he/she believes to be erroneous or invalid for some
reason (i.e., typo, spelling mistake, missing graphic, ambiguous question, etc.). The student
may challenge the question by clicking the hand icon on the toolbar, or by selecting “Challenge
This Question” from the Help menu. This allows the student to type a short description of the
error. You may view, print, or download some or all of these Question Challenges. These
Challenge questions are to downloaded and sent to HQ AFCESA/CEOF quarterly.

12. Transferring Student Records Between Bases: When a person leaves (PCS) your unit,
they should “hand carry” a disk copy and a hard copy of their CerTest status training to their
gaining unit. The CerTest program manager copies a student’s record to a diskette 3 %"
diskette using the “Copy to Diskette” option found in the File menu of CerTest. Include any
additional records (paper) that show completed training. The losing unit will maintain the
student’s record in their CerTest database for at least 120 days before deleting it from the
computer system. Suggestion: Add this procedure to your unit’s out/in-processing checklist.

13. Program Errors: If a program error occurs, write down the information exactly as it
appears on the computer screen, then contact the CerTest Program Manager for Operations,
SMSgt Jim Lucas, HQ AFCESA/CEOF, DSN: 523-6380.

14. CFC/HCFC Certification and Testing: The Environmental Protection Agency (EPA)
mandated effective November 14, 1994, persons that maintain, service, or repair refrigeration
and air conditioning systems containing chlorofluorocarbons (CFC) and/or
hydrochloroflorocarbons (HCFC) must be certified by an approved certification program. In
February 1994, EPA approved the 366 TRS/TTM, Sheppard AFB TX (Air Force Civil Engineer
Technical Training School) to be the DOD CFC Certifying Agent.

a. There are four types of certification:

Type | (household appliances)

Type Il (high pressure systems)

Type lll (low pressure systems)

Universal Technician (encompasses all types)**

**Note: All Air Force Civil Engineers requiring certification (primarily HVAC/R
personnel) will be certified to the Universal Technician Level.

b. If you, as the unit’'s CerTest Program Manager, wish to load the chlorofluorocarbons

(CFC) and/or hydrochloroflorocarbons (HCFC) Certification tests and DO NOT already have
them on your system(s), complete the installation, then enter CerTest and select Enable Secure
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Tests available under the File pull down menu. You will have to call the appropriate point of
contact displayed on the Enable Secure Test Groups screen to obtain the appropriate Enable
Code.

c. All CerTest CFC/HCFC test proctors must be designated in writing. This appointment
letter must include a statement that states they have read and understand all CerTest program
requirements listed in this CerTest Procedural Guide. A copy of this letter must be forwarded to
the DoD Administration Center and an info copy must be forwarded to your command or service
component representative. The letter should be formatted and contain the information included
on the sample located on page 9 of this guide.

d. Test Administration. The CFC Certification program has a Universal Pretest and
Posttests for each level. At least one CerTest program manager will proctor personnel testing.
The examinee will need to bring a Pressure Temperature Chart and calculator while testing. No
other study materials will be allowed in the test room/area.

e. BEFORE ADMINISTERING A TEST: Verify the identity of individuals taking CFC
certification tests by examining photo identification. Acceptable identification includes, but are
not limited to drivers’ licenses, government identification cards, or passports.

f. Examinees should be prepared to sit through the test until complete. Only the testing
examinee will be allowed at a computer while the test is in progress. Personnel are not allowed
to take “practice tests” or review any tests.

NOTE: Once testing has started, an entry must be made every five minutes; otherwise,
the computer program will terminate the test and a “failed” score will be recorded.

g. Pretest: It's recommended that personnel take the pretest before taking any
certification tests. The Pretest is at the back of the CFC Study Guide/Workbook.

h. Posttest: All examinees must take the Core Test before taking any other tests. Only
one CFC Test should be unlocked at a time.

i. Test Failures: If an examinee should fail a test, print them a copy of the “test
summary” (test summary identifies areas the trainee may require additional training). All test
failures should result in the trainee receiving supervised, remedial training. After remedial
training has been completed, retest the examinee. If the examinee again fails the test, the
commander should be notified and appropriate action taken.

j- Record Keeping: Once an examinee passes their required level of certification (AF
Civil Engineers must be Universal certified), print two copies of the “student record”. Test
proctors must provide the following information on both copies: Name, SSAN, signature, and
verification statement that the Certification level is correct. Put one copy of the “student record”
in the examinees training/personnel folder. Send the other copy, along with a 3 74" disk
containing downloaded statistical data and the electronic student record will be sent to the DoD
CFC/HCFC Administration Center.

k. Use the File pull down menu and "Copy to Diskette", and " Statistical Data Ultilities " to
download the student record and statistical data. Follow the directions on the screen. Send the
3 12" disk, the printed student record, and a return 3-line address:

123 CES/CE
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56 FLIGHT AVE.
ANYWHERE AFB TX 74201

. If a copy of the test summary is needed at a later date, it can be recalled by entering

into the Student Record section and selection “DETAIL”. The computer program will retain this
information for 90 days from the test date before its automatically deleted.

17



16. CerTest Points of Contact: Base-level CerTest program managers should contact the
DoD CerTest program manager if assistance is needed.

a. The DoD Administration Center for the CFC/HCFC Program is:

Mr. Ron Lawson, 366 TRS/ TTM (CFC/HCFC)

727 Missile Rd. Sheppard AFB, TX 76311-2254;

DSN: 736-5793/5809 Commercial (940) 676-5793/5809;
DSN FAX: 736-2768 Commercial FAX: (940) 676-2768;
E-mail: ron.lawson@sheppard.af.mil

b. The DoD/Air Force Fire OPR for CerTest is:

CMSgt Jim Podolske, HQ AFCESA/CEXF

139 Barnes Drive, Suite 1, Tyndall AFB, FL 32403
DSN: 523-6321 Commercial (850) 283-6321;
DSN FAX: 523-6390 Commercial (850) 283-6390;
E-mail: jim.podolske@tyndall.af.mil,

Web Site — www.afcesa.af.mil

c. The DoD/Air Force Operational OPR for CerTest is:

MSgt Scottie Spradlin, HQ AFCESA/CEOF

139 Barnes Drive, Suite 1, Tyndall AFB, FL 32403
DSN: 523-6380 Commercial (850) 283-6380;
DSN FAX: 523-6488 Commercial (850) 283-6488;
E-mail: scottie.spradlin@tyndall.af.mil

Web Site — www.afcesa.af.mil
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Test Proctor Letter (Sample):

DEPARTMENT OF THE AIR FORCE
ANY CE SQUADRON, (MAJCOM)

ANYBASE AIR FORCE BASE, ANYWHERE

MEMORANDUM FOR 366 TRS/TTM (CFC/HCFC))
727 Missile Road

Sheppard AFB, TX 76311-2254

ATTN: Mr. Ron Lawson

FROM: XXX CES/CCQT

1111 Anystreet, Suite 10

Anybase, Anywhere 11111-0001

SUBJECT: CERTEST Proctors

1. As requested, this letter identifies the CFC/HCFC Proctor(s) for the (your unit) CES at (your

base) AFB, (your State).

2. All proctors, by signing this letter, state that they have read and fully understand all CerTest
program requirements listed in the CerTest Procedural Guide. Failure to follow the procedures
listed for CFC/HCFC testing is in direct violation of Environmental Protection Agency Guidelines

and is punishable by federal law.

NAME RANK SSAN

ADDRESS

DSN

Terry B. Smith  MSgt 123-45-6789

SIGNATURE

Kerri C. Jones  SSgt 222-22-2222

SIGNATURE
CE COMMANDERS SIGNATURE

1111 Balboa Dr

1111 Balboa Dr
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1. PURPOSE

Based on customer feedback, we have created this document to help our customers
perform the most common tasks in the CerTest computer-based testing program. As
you become comfortable using CerTest and begin performing more advanced functions,
you can obtain help performing these functions by using the Help pull-down menu in
CerTest to access information or instructions on the topic you need help with.

Before printing this document view it using the Print Preview function to ensure that the
pages correspond with the Table of Contents.

2. CERTEST OVERVIEW

CerTest is an interactive computer-based certification and testing program designed to
test and certify a student's knowledge of various job-related subjects. CerTest has been
in use since 1989 and transitioned to the Windows environment in the fall of 1995.
CerTest has been used by thousands of personnel worldwide.

While CerTest is distributed with a number of tests already in the system, it is a program
that is much more powerful than a standard test display mechanism. Tests within
CerTest use a variety of question types, including true/false, multiple choice, fill-in-the-
blank, matching, sequencing, multiple/multiple choice, and graphic identification. In
addition, scenarios can be used with any question type so that students can be tested on
application-type knowledge. Any training materials, such as videotapes, print-based
materials, and multimedia programs can be used with the CerTest system.

CerTest has two primary parts; the student section and the management section. In the
student section, students can take tests and manage their training schedule by keeping
track of their student record.

Using CerTest, you can perform a number of management functions. Most of these
functions are available by accessing one of four lists available from the File menu; the
Student List, Manager List, Test List, and Graphics Library.

Using the Student List, you can add and delete students to CerTest and keep track of
your student's records and progress. In addition, managers must “unlock” each test for
the students. Within the Student List, you may view lists of students within the system,
or may focus on one student's record. This record contains the student's status for each
test as well as lock/unlock information and historical data about specific tests.

There may be a number of managers in the CerTest system at any one time, and
different managers may have different privileges. You can refer to the Manager List to
see what privileges are available to you or to add another manager with comparable
privileges. However, do not add a manager to CerTest unless you have been authorized
to do so. The program will allow only three managers have test locking/unlocking
privileges at any one time.

The Test List is the most powerful feature of CerTest. It is this feature that turns CerTest
for Windows from a test display mechanism to a training development tool. The test list
is the area of CerTest where you, as a manager, can create your own tests and track
data about tests already in the system.
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When developing tests, you can create questions using any of the seven question types
and can build scenarios into any question. You can also set the criterion level, provide
section information, add notes about the test for the student, and set the size of the
question pools.

In addition, graphics may be used to support any question type. Thus, when developing
a test, go to the Graphics Library to pull graphics into your questions. CerTest is
distributed with hundreds of graphics. When developing a test, you may use the
graphics already in the Graphics Library, or you can import select graphics into the
library from other graphics packages.

In addition to the four available lists, there are other features in CerTest for Windows
such as the ability to customize and print a variety of reports, statistical data collection,
the ability to upload and download student records and tests, and back-up and restore
features.

Security is an important part of the CerTest system. Thus, there are a number of
"security features" built into CerTest. First, for both students and managers, entry into
CerTest is password protected, and passwords are encrypted. Also, all tests in the
system are "locked" and managers must unlock each test before a student has access.
Most tests will automatically lock once it has been passed once or failed twice. Access
to that test is then only available to a student if a manager unlocks the test again.

Another security feature is the three-randomization techniques used in CerTest. First,
test questions are pulled from a pool of questions. Secondly, once the questions have
been determined, they appear in a random order. Finally, for multiple choice,
multiple/multiple choice, matching, and sequencing questions, the responses are
displayed in a random order. Additionally, all CerTest student, manager, and test data is
encrypted.

All tests distributed within CerTest have gone through an extensive test development
process that included reviews by both test development experts and subject matter
experts. However, if a student wishes to challenge a test question, he/she may
challenge the question by clicking the hand icon on the toolbar, or by selecting
“Challenge This Question” from the Help menu. This allows the student to type a short
description of the error. You may view, print, or download some or all of these Question
Challenges. See the “Challenging Questions” section of this guide for more details.

3. HOW TO START CerTest
1. From the Program Manager, double-click on the CerTest icon.
2. Click on the CerTest title screen to get to the log-on screen.
3. Enter the following Social Security Number and password.

If you are installing CerTest on a computer for the first time, your system comes pre-
loaded with the manager Sir Test. To log-on as “Sir Test”, type:

Social Security Number: 123-45-6789
Password: CE
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4. Site Information: After you log-on to CerTest the first time, you will be asked to
enter your Site Name. The Site Name consists of your base name followed by
a computer designation/location. This will only need to be done once per
computer.

Example: Tyndall AFB FL
Computer #1

**Once you have added yourself as a manager (with all privileges); log on once
again using your log on information. Then delete “Sir Test”. Until you have
deleted “Sir Test” your CerTest is NOT secure and subject to compromise!!

4. HOW TO OPEN STUDENT LIST

To open the student list:

1. Select File (menu bar).
2. Select Open Student List.

Use the Specialty drop-down list box to limit the student list to only students in a specific
specialty.

Shortcut keys:
CTRL + S will also open the student list.
5. HOW TO ADD A STUDENT
1. Open Student List.
2. Select Edit (menu bar).
3. Select Add Student.
4. On the New Student Information screen:
a) Student's Last Name
b) Student's First Name
c) Student's Social Security Number (SSN)
d) Rank and Middle Initial are optional.
Select:
a) Specialty by double clicking on the student's career-related AFSC
5. Select Password.

6. In the Change Student's Password dialogue box:
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a) Input the New Password.
b)  Verify the password by inputting what was typed in the New Password text box.
c) Select OK.

7. Select OK on the Student Information screen.

A system message displays informing you that the student you enrolled has
been added.

8. Select OK in the system message box.
Shortcut keys:

Pressing the SHIFT + INSERT keys or clicking on the "+" icon in the tool bar will replace
steps 2 and 3.

Additional information:

A student may enroll in more than one Specialty at a time. This is not the norm but if
you find a need for this capability, it is available to you by just double-clicking on a
second Specialty.
6. HOW TO DELETE A STUDENT

1. Open Student List.

2. Highlight the student's name for deletion.

3. Select Edit (menu bar).

4. Select Delete Student.

5. Select Yes in the Delete Student(s) confirmation box.

Warning: Deleting a student removes ALL the student's records (test scores and
history) from the CerTest System.

Shortcut keys:
SHIFT + DELETE will replace steps 3 and 4.

Additional Information:

You may select multiple students for deletion.
7. HOW TO EDIT STUDENT INFORMATION

1. Open Student List.
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2. Highlight the name of the student whose information you want to update or
change.

3. Select View (menu bar).

4. Select Student Info.

5. The Student Information screen displays. You can edit/change the student's
information and/or password on this screen.

Shortcut:
Clicking on the "i" icon will replace steps 3 and 4.
8. HOW TO LOCK AND UN-LOCK TESTS
Locking and unlocking a test allows the manager to open a test for a student to take or
close a test to prevent a student from taking or viewing it. If a test is locked, a key is
displayed to the left of that test's name on the Student Record screen.

1. Open Student List.

2. Highlight the name of the student whose record you want to view.

3. Select View (menu bar).

4. Select Student Record.

5. Highlight the desired test for locking or unlocking on the Student Record
screen.

6. Click on the key icon directly below the menu bar.
Helpful Hints:
You can double-click on the lock column next to a test to toggle the lock status.

You can use the L and U keys to Lock or Unlock tests instead of the key icon in the tool
bar.

Note: Only three (3) CerTest managers have the Lock/Unlock Tests privilege at a
time.

For test security purposes, each student may have only one (1) Hazardous Materials
test (tests 8501 through 8512) unlocked at a time.

For test security purposes, when a student exits CerTest, any unlocked Hazardous
Materials test will be locked for that student. A manager will have to unlock the test
before the student may take the test.

Additional Information:
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You can lock and unlock more than one test by:

1.

Pressing the CTRL key while clicking on a test will make an additional selection
without deleting any previous selection(s).

Pressing the SHIFT key while clicking on another test will select that test and
all the tests between an earlier selection and your current selection.

To lock/unlock a test for multiple students at once:

1.

2.

Open Test List.

Highlight the test you want to lock/unlock.

. Click on the key icon directly below the menu bar.

Highlight the students for whom you wish to lock/unlock the test.

Click the Unlock button to unlock the test for the highlighted students, or click
the Lock button to lock the test.

To exit the Student Record screen:
Press CTRL + S.

9. HOW TO BOOKMARK A QUESTION

When taking a test, a student may choose to mark a question and return to it later before
the test is exited and scored.

To bookmark a question:

1.

Click on the Bookmark check box (lower left hand corner of the computer
screen).

Name the bookmark or accept the name provided.
Select OK.

Select Next to move forward in the test or the back arrow to move backward in
the test.

To return to a bookmarked question:

1.

2.

Select Bookmark (menu bar).

Select the desired bookmark.

To release a desired bookmarked question:
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1. Click on the Bookmark check box (lower left screen).

Additional Information:

When you choose to Exit and Score a test, a system message appears if you have any
bookmarked questions. This message asks you if you want to exit with questions still
bookmarked.

10. HOW TO MOVE WITHIN A TEST
To move forward one question at a time within a test:
1. Select Next (located in the top left-hand corner of computer screen)
or...
2. Press Enter or Select the View (menu bar)

3. Then Select Next Question or CTRL + N
or...

4. Click on the arrow button located on the horizontal scrolling bar in the lower
right-hand corner of the test screen

To move forward one or more questions at a time:
1. Drag the horizontal scrolling bar to the right.
To move backwards one question at a time within a test:
1. Select the left arrow icon in the tool bar (located left of Next button)

or...

2. Select the View (menu bar) and Select Previous Question or Press the CTRL +
P keys

or...

3. Click on the left arrow located on the horizontal scrolling bar in the lower right-
hand corner of the test screen.

To move backward one or more questions at a time:
1. Select the Bookmark (menu bar).
2. Select Last Viewed Question

or...
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3.

Drag the horizontal bar in the lower right-hand corner of the test screen to the
left.

11. HOW TO VIEW A DETAIL TEST RECORD

The details of a student's individual tests are found on the Test Summary screen.

To display the details of a student’s test:

1.

o

8.

Open Student List.

Highlight the student whose tests' results you want to view.

Select View (menu bar).
Select Student Record.

Highlight test on Student Record you want to view.

Select View (menu bar).

Select Detail.

Test Summary screen appears.

Select Cancel to exit when you are finished viewing.

12. HOW TO VIEW A TEST SUMMARY

The Test Summary screen is used to view the detail of one of the tests an individual
student took. It indicates how a student scored on the test.

The Test Summary contains:

The student's score

The passing score for the test

Whether or not the student passed the test

Number of questions presented and correct for each section of the test

Student Record

The Student Record screen displays the student's CerTest profile.

To view a Student's Record:

1.
2.

3.

Open Student List.

Highlight the name of the student whose record you want to view.

Select View (menu bar).
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4. Select Student Record.

5. Student Record screen displays. This screen displays the student's test profile.
This profile includes:

a) Student's Specialty

b) What tests the student is authorized to take

c) Each test's statistics

d) The student's test score, the test score's date, and the number of times the student
took the test

To exit the Student's Record:

Press CTRL + S.
Helpful Hints:

* Double clicking on a student replaces steps 2 through 4.
* Pressing the Enter key replaces steps 3 and 4.

13. HOW TO VIEW STUDENT RECORDS
The Student Record screen displays the student's CerTest profile.
1. Open Student List.
2. Highlight the name of the student whose record you want to view.
3. Select View (menu bar).
4. Select Student Record.

5. Student Record screen displays. This screen displays the student's test profile.
This profile includes:

a) Student's Specialty

b)  What tests the student is authorized to take

c) Each test's statistics

d) The student's test score, the test score's date and the number of times the student
took the test

To exit the Student's Record:

Press CTRL + S.
Helpful Hints:

* Double clicking on a student replaces steps 2 through 4.
* Pressing the Enter key replaces steps 3 and 4.
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14. HOW TO PRINT A STUDENT RECORD

The Print function allows you to print a hard copy of a Student Record.

To print a student record:

1.
2.

8.

9.

Open Student List.

Double-click on the student whose record you want to view/print. Student
Record screen displays.

Select File (menu bar).
Select Print.
Report Format box displays.

Click on the Display Social Security Number check box if you do not want the
student's Social Security Number to appear on the printout.

Select Print Full Record, Organized by Training Area to print all the
posttests in the student's record, organized by Training Area. Any Filter/Sort
options will be ignored when printing using this option.

or...

Select Print Record as Currently Displayed to print only those tests that are
displayed as a result of the current Filter/Sort options. This print will also be
limited to only the selected Training Area (if not All Training Areas).

The Print Preview screen displays.

Select the printer icon from the tool bar at the top of the screen.

Select Print Range. (The default is all pages.)

Input number of copies. (The default is 1.)

10. Select OK. The Student Record screen displays:

Shortcut:

Click on printer icon in tool bar to replace steps 3 and 4.

15. HOW TO COPY A STUDENT’S RECORD TO A DISKETTE

You may want to back up one or more students' record(s) from the CerTest system to a
diskette. This backup copy can be used to reinstall a student record(s) that was deleted
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from the CerTest system, to copy a student record from one computer system to
another, or to replace a student record that has become corrupted. If a student record
becomes corrupted, the student should be deleted before you copy student from
diskette.

1. Open Student List

2. Highlight the student(s) to copy.

3. Select Copy to Diskette (File pull-down menu).
4. Select Yes in the Copy Student(s) box.

5. In the Copy Student(s) To box:

Select:

* The drive containing the target diskette
* The Directory

® The file name in the File Name test box
6. Select OK.
7. Select OK in the Copy Complete information box.

Shortcut Key: Pressing the F8 key or clicking on the disk icon in the tool bar replaces
step 3 above.

Helpful hint: You may copy more than one student record at a time by selecting multiple
records. To select a block of student records, highlight the first student in the block then
press and hold the SHIFT key while clicking on the last student in the block. To select
multiple student records that are not in sequence, press and hold the CTRL key while
clicking on each record you want to copy.

Additional information: Student files have an .std extension. When you copy students to
a diskette, a text file is also created on the diskette. This text file has the same name as
the student file, but has a .txt extension. The text file contains a list of all students
copied into the student (.std) file and may be viewed using Windows® Notepad.

16. HOW TO COPY A STUDENT’S RECORD FROM A DISKETTE

You may want to copy a student record from a diskette in order to reinstall a student who
has been deleted from the CerTest system or to move a student from one computer
system to another. If a student record is corrupted, the student should be deleted before
the record is copied to the system from a diskette.

31



If you copy a student from a diskette and the student already exists in the system, you
will be given the option to merge the record on the diskette with the record on the
system. The new student record on the system will contain a history of when each test
was taken, but will contain a summary of only the most recent time each test was taken.
To Copy a Student from Diskette:

1. Select Copy From Diskette (File pull-down menu).

2. On the Copy From screen:

® Student from the List Files of Type drop-down list box
* The drive containing the source diskette
* The source file name

3. Select OK.
4. If more than one student record was copied into the selected file, you must
select the student record(s) you want to copy in the Copy Students Into

CerTest list box. Select copy.

5. Select OK in the Copy Complete information box.
Helpful Hint:

* |If you start this process with Open Student List, CerTest will automatically
select Student in the List Files of Type field, allowing you to skip this entry in
Step 2 above.
17. HOW TO PRINT THE STUDENT LIST
The Print function allows you to print a hard copy of the Student List.
1. Open Student List
2. Select File (menu bar).
3. Select Print.

Report Format box displays.

The format options available are:

* Organize students by Specialty
* Display Rank
* Display Social Security Number
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You can choose one or all of these options to format your printout by clicking on the
desired check box(es). The default is Display Rank so you will have to deselect it if you
do not want this option.

4. Select or deselect the format options. Then select OK.

Print Preview screen displays.

5. Select printer icon in tool bar.

6. Select Print Range. (The default is all pages.)

7. Input number of copies. (The default is 1.)

8. Select OK.

The Student List screen displays:

Shortcut:
Click on printer icon in tool bar to replace steps 2 and 3.
18. HOW TO OPEN THE MANAGER LIST
Open Manager List displays all the managers who have access to CerTest.

1. Select File (menu bar).

2. Select Open Manager List.
Shortcut keys:
CTRL + M will also open the manager list.
19. HOW TO ADD A MANAGER
Add Manager registers an individual as a manager in the CerTest system.

1. Open Manager List.

2. Select Edit (menu bar).
3. Select Add Manager.

4. On the New Manager Information screen:

a) Input:

* Manager's Last Name
* Manager's First Name
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®* Manager's Social Security Number (SSN)
* Rank and Middle Initial are optional fields.

b) Deselect, if necessary, any Specialty you do NOT want this manager to be able to
work within by double clicking on the career-related AFSC

5. Select Password.
6. Inthe Change Manager's Password dialogue box:
a) Input New Password.
b) Verify Password by inputting what was typed in the New Password text
box.
c) Select OK.
7. Select Privileges
Within the CerTest system, a manager can have three types of privileges. These are
Test, File, and Personnel privileges. The Privileges screen displays these privilege
types and subdivides the responsibilities within each type into check box options.
Note: A maximum of three (3) managers may be given the Personnel privilege to
Lock/Unlock Tests. If your CerTest system has three managers with the Lock/Unlock
Tests privilege, you must remove this privilege from one of these managers before you
may give it to another manager.
8. To change the default selections for a privilege on this screen:
Click on the desired option's check box.
9. When the screen reflects the desired privileges for this manager, select OK.

10. Select OK on the New Manager Information screen.

A system message displays informing you that the new manager you enrolled
has been added.

11. Select OK in the system message box.
Shortcut keys:
SHIFT + INSERT will replace steps 2 and 3.
Note: You cannot give a new manager privileges that you do not have.
20. HOW TO DELETE A MANAGER
Delete Manager removes a manager from the CerTest system.

1. Open Manager List.
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4.

5.

Highlight the manager's name for deletion.
Select Edit (menu bar).
Select Delete Manager.

Select Yes in the Delete Manager(s) confirmation box.

Shortcut keys:

SHIFT + DELETE will replace steps 3 and 4.

Note: You may not edit or delete a manager that has privileges that you do not have.

21. HOW TO EDIT A MANAGER’S INFORMATION

Edit Manager Information allows a CerTest manager to update and/or change another
CerTest manager's information.

1.

2.

Open Manager List.

Highlight the name of the manager whose information you want to update or
change.

Select View (menu bar).

. Select Manager Info.

The Manager Information screen displays. You can edit/change a manager's
information and/or password on this screen.

To change the manager's privileges, select Privileges

Within the CerTest system, a manager can have three types of privileges.
These are Test, File, and Personnel privileges. The Privileges screen displays
these privilege types and subdivides the responsibilities within each type into
check box options.

Note: A maximum of three (3) managers may be given the Personnel privilege
to Lock/Unlock Tests. If your CerTest system has three managers with the
Lock/Unlock Tests privilege, you must remove this privilege from one of these
managers before you may give it to another manager.

To change a privilege on this screen:

Click on the desired option's check box.

. When the screen reflects the desired privileges for this manager, select OK.

Select OK from the Manager Information screen to save the changes.
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Shortcut keys:
Clicking on the "i" icon in the tool bar can be used in place of steps 3 and 4.
22. HOW TO PRINT THE MANAGER LIST
The Print function allows you to print a hard copy of the Manager List.
To print the manager list:
1. Open Manager List.
2. Select File (menu bar).
3. Select Print.
Print Preview screen displays.
4. Select printer icon in tool bar.
5. Select Print Range. (The default is all pages.)
6. Input number of copies. (The default is 1.)
7. Select OK.
The Manager List screen displays.
Shortcut:
Click on printer icon in tool bar to replace steps 2 and 3.
23. HOW TO OPEN THE TEST LIST
Open Test List displays all the tests currently available within the CerTest system.
1. Select File (menu bar).
2. Select Open Test List.
All the tests available within the CerTest system are available for viewing in the Tests
box when you first open the test list. Use the Specialty and Training Area drop-down list
boxes to limit the test list to only tests in a specific Specialty and/or Training Area.
Shortcut keys:

CTRL + T will also open the test list.
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24. HOW TO ADD A TEST

Add Test creates a test and adds that test to the CerTest system. Test questions are
then created using Edit Test.

1.

2.

Input:

Select:

5.

Open Test List.
Select Edit (menu bar).
Select Add Test.

On the Test Information screen:

Test Number (Test numbers 100 through 999 and 8000 through 9999 are
reserved for DoD Wide tests.)

Test Name

Passing Criterion (This determines what score the student must get in order to
pass the test.)

Specialty/Training Area
Statistical Data Type

Select OK.

Note: A test must be in at least one Specialty/Training Area.

Shortcut keys:

Pressing SHIFT + INS or holding down the SHIFT key while clicking on the plus icon on
the tool bar can be used in place of steps 2 and 3.

25. HOW TO DELETE A TEST

Delete Test erases a test from the CerTest system. Before a test can be deleted, all the
questions for that test must be deleted using Remove Question.

Warning: Once a test is deleted, you will not be able to undo the deletion. You will
have to recreate the test. Also, any students who have taken the test will lose their
score/detail record/history for the test.

1.

2.

Open Test List.

Highlight the desired test.
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3. Select Edit (menu bar).

4. Select Delete Test.

5. Select Yes.

Shortcut keys:

Pressing SHIFT + DEL or holding down the SHIFT key while clicking on the scissors
icon in the tool bar can be used in place of steps 3 and 4.

26. HOW TO ENABLE SECURE TESTS

Some tests within CerTest are Certification tests and will not be available without
permission from the Air Force Project coordinator listed in your CerTest Procedural
Guide. These tests are:

EPA CFC Tests:
8000 CFC Core Test
8001 CFC Type | Test
8002 CFC Type Il Test
8003 CFC Type lll Test

Hazardous Materials Tests:

8501
8502
8503
8504
8505
8506
8507
8508
8509
8510
8511
8512

CDC 47201
CDC 47201
CDC 47202
CDC 47202
CDC 47202
CDC 47202
CDC 47203
CDC 47203
CDC 47203
CDC 47203
CDC 47205
CDC 47205

Awareness (Test A)
Awareness (Test B)
Operations - Part 1 (Test A)
Operations - Part 2 (Test A)
Operations - Part 1 (Test B)
Operations - Part 2 (Test B)
Technician - Part 1 (Test A)
Technician - Part 2 (Test A)
Technician - Part 1 (Test B)
Technician - Part 2 (Test B)
Incident Commander (Test A)
Incident Commander (Test B)
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To enable either group of tests, you must call the point of contact (POC) listed in the
Procedural Guide, give them your eight digit Site Code, and get the corresponding eight
digit Enable Code.

To Enable Secure Tests:

1. Select Enable Secure Tests from the File menu.

2. Highlight the Test Group you wish to enable.
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3. Contact the POC identified in the Contact Information box, and give them your
eight digit Site Code. The POC will then give you a corresponding eight digit
Enable Code.

Note: Your Site Code may be different for each Test Group. Be sure the correct Test
Group is highlighted when you refer to the Site Code.

3. Enter the eight digit Enable Code and select OK.
Note: The POC may not be available when you call. Leave your Site Code and the
POC will call you back. When you receive the Enable Code, select Enable Secure Tests
again and enter the Enable Code.
27. HOW TO PRINT THE TEST LIST
The Print function allows you to print a hard copy of the Test List.

1. Open Test List.

2. Select File (menu bar).

3. Select Print.

Report Format box displays.

4. Click on the Organize Tests by Location check box if you want the printout to
include all the Specialties/Training Areas each test is assigned to.

5. Click on OK.
Print Preview screen displays.

6. Select printer icon in tool bar.
7. Select Print Range. (The default is all pages.)
8. Input number of copies. (The defaultis 1.)
9. Select OK.

The Test List screen displays:

Shortcut:

Click on printer icon in tool bar to replace steps 2 and 3.

28. HOW TO COPY A TEST TO DISKETTE
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You may want to back up individual tests from the CerTest system to a diskette. This
backup copy can be used to reinstall a test that was deleted from the CerTest system, to
copy a test from one computer system to another, or to replace a test that has become
corrupted.

1. Open Test List.

2. Highlight the desired test(s).

3. Select Copy To Diskette (File pull-down menu).

4. Select Yes in the Copy Test(s) box.

5. On the Copy To screen:

* The drive containing the target diskette
® The Directory

® The target file name

6. Select OK.

7. Select OK in the Copy Complete information box.
Shortcut Key:
Pressing the F8 key or clicking on the disk icon in the tool bar replaces step 3 above.
Helpful Hint: You may copy more than one test at a time by selecting multiple tests. To
select a block of tests, highlight the first test in the block then press and hold the SHIFT

key while clicking on the last test in the block. To select multiple test records that are not
in sequence, press and hold the CTRL key while clicking on each test you want to copy.

Additional information: Test files have an extension of .tst. When you copy tests to a
diskette, a text file is also created on the diskette. This text file has the same name as
the test file, but has a .txt extension. The text file contains a list of all tests copied into
the test (.tst) file and may be viewed using Windows® Notepad.

29. HOW TO COPY A TEST FROM DISKETTE

You may want to copy a test from a diskette in order to reinstall a test that has been
deleted from the CerTest system, to copy a test from one computer system to another,
or to replace a test that has become corrupted.

1. Select Copy From Diskette (File pull-down menu).

40



2. On the Copy From screen:

* Test from the List Files of Type drop-down list box.

* The drive containing the source diskette from the Drives drop-down list box
* The Directory

* The source file name from the File Name list

3. Select OK.
4. If more than one test record was copied into the selected file, you must select
the test record(s) you want to copy in the Copy Tests into CerTest list box.

Select Copy.

5. Select OK in the Copy Complete information box.
Helpful Hint:

* [f you start this process with Open Test List, CerTest will automatically select
Test in the List Files of Type field, allowing you to skip this entry in step 2
above.
30. HOW TO ASSIGN A TEST TO A SPECIALTY OR TRAINING AREA
Specialties are career-related AFSCs. Training Areas are subdivisions of Specialties.
Tests must be assigned to one or more Specialties. Within each Specialty the test must
be assigned a Training Area. The Training Area determines where in the Specialty the
test will appear for a student.

A Training Area Pretest is composed of designated questions from all the sections in all
the tests assigned to a Training Area.

1. Double-click on the desired Specialty in the Specialty/Training Area Location
list box on the Test Information screen.

2. Highlight the desired Training Area within the Training Area list box.
3. Select OK.
Observation:

A blue check mark displays next to the Specialty. The Training Area is displayed below
the Specialty with a blue connecting line.

Note: Pretests for Training Areas will automatically be updated to include the Pretest
designated questions from the tests assigned to the Training Areas.
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31. HOW TO MOVE A TEST TO ANOTHER TRAINING AREA

Moving a test to another Training Area within a Specialty does not affect student
scores/detail records/history for that test.

1. Open Test List.

Highlight the desired test.
Select View (menu bar).

> N

Select Test Info.

5. Double-click on the Training Area you wish to move the test from in the
Specialty/Training Area Location box.

The Training Area List is displayed.

6. Select a new Training Area within the Specialty by:

* Highlighting the new Training Area in the Training Area List.
* Selecting OK.

7. Verify the change on the Test Information screen.
8. Select the OK button on the Test Information screen.

Helpful Hint:

To find all the tests assigned to a specific Training Area, select the Training Area from
the Training Area drop-down list box on the Test List screen. (Be sure All Specialties
are selected in the Specialty drop-down list box on the Test List screen.)
32. HOW TO OPEN A TRAINING AREA LIST
Open Training Area List displays all the available Training Areas in CerTest.

1. Select File (menu bar).

2. Select Open Training Area List.

Training Areas screen displays.

33. HOW TO ADD A TRAINING AREA
All tests are located in Training Areas and Specialties. You can create Training Areas
as a way to group the tests that you develop. There is one generic Site Specific Training

Area; however, you can customize the Training Area, or create additional site specific
Training Areas.
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When you add a Training Area, it will be site specific unless you have DoD-wide test
privileges.

1.
2.

3.

Open Training Area List.
Select Edit (menu bar).

Select Add Training Area.
Training Area Information box displays.
Input a name for the new Training Area in the Training Area Name text box.

Managers cannot add a DoD Wide Training Area unless they have the
create/edit DoD Wide Tests privilege.

If you have DoD Wide Tests privilege and you want to add a DoD Wide
Training Area, you will need to deselect the Site Specific Training Area check
box.

If you wish a pretest to be generated for the named Training Area:
* Select Pretest Available by clicking on the check box.
* Select Pretest Info button.

* The default for the Pretest Name is the Training Area name with "Pretest”
added. The default Pretest Name can be edited.

Use the up and down arrows above and below the word "Move" and to the right
of the box labeled Location in Training Area List to select where the new
Training Area will appear in the Training Area List.

Note: Any Training Area above the dotted line is DoD Wide. Any Training
Area below the dotted line is Site Specific.

Select OK to add the Training Area at the indicated position to the Location in
Training Area List.

34. HOW TO DELETE A TRAINING AREA

Delete Training Area removes the Training Area from the CerTest System. Before a
Training Area can be deleted, all the questions and any test(s) associated with that
Training Area must be deleted/removed from the CerTest system or the tests in that
Training Area must be moved to another Training Area.

Warning: Once a Training Area is deleted, you will not be able to undo the
deletion. You will have to add the Training Area again and recreate or reassign
the test(s). Also, any students who have taken the test will lose their score/detail
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record/history for the test if you delete the test or move the test from a student's
specialty.

1. Before deleting a Training Area, you must first move all tests assigned to that
Training Area into another Training Area, or Delete All Tests in that Training
Area.
2. Open Training Area List.
3. Highlight the Training Area you wish to delete.
4. Select Edit (menu bar).
5. Select Delete Training Area.
If a Training Area contains tests when you try to delete it, a system message
displays informing you that the Training Area may not be deleted until all tests
are removed from it.
35. HOW TO VIEW THE TRAINING AREA INFORMATION SCREEN
The Training Area Information screen is accessed through View in the menu bar. On
this screen you can change the selected Training Area's name, select/deselect Pretest
Available, add/edit the Pretest Information if Pretest Available is selected, and/or move
the selected Training Area to a new location in the Training Area list.
1. Open Training Area List.
2. Highlight the desired Training Area.
3. Select View (menu bar).
4. Select Training Area Info.

Training Area Information screen displays.

Note: Managers cannot view the Training Area Information on a DoD Wide
Training Area unless they have the create/edit DoD Wide Tests privilege.

5. On the Training Area Information screen, you can:
* Edit the selected Training Area's name.
* Select/deselect Pretest Available.

®* Move the selected Training Area to a new location in the Training Area list
using the up and down arrows next to the Location box.

The Training Area Information screen contains the following buttons:
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* Pretest Info, which allows you to add/edit the Pretest Information if Pretest
Available is selected.

* Help, which will display the available information on this screen.

® Cancel, which returns you to the Training Area List without saving any changes
made to the information on this screen.

* OK which returns you to the Training Area List screen and saves the changes
made to the information on the Training Area Information screen.

36. HOW TO VIEW ALL RECORDS IN A SPECIALTY & PRINT A REPORT
This is one of the report options in the Report pull-down menu. If you make no changes
to the Report Options screen, this menu option will print a report by specialty. Under
each Specialty, each student assigned to that specialty will be listed alphabetically.
Under each student's name, all the tests in the student's record will be listed and sorted
by Training Area. The lock status, title, test status (needed, passed, or failed), score,
date last taken, and number of attempts will be indicated for each test.
To choose the All Records in a Specialty option and print the report:

1. Select Reports (menu bar).

2. Select All Records in a Specialty.

Report Options screen displays.
3. Select Print Report.
Print Preview screen displays.

4. Select printer icon in tool bar.

5. Select Print Range. (The default is all pages.)

6. Input number of copies. (The default is 1.)

7. Select OK.
Important Note: Depending upon the number of students you have enrolled, it may
take several minutes (possibly hours) to generate the report before it displays on the
Print Preview screen. The more you filter and limit the report, the faster the report will be
generated.

37. HOW TO CHOOSE THE TESTS TAKEN IN THE LAST 30 DAYS & PRINT

This is one of the report options in the Report pull-down menu. If you make no changes
to the Report Options screen that displays after you make this selection, a report by
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specialty for each student assigned to that specialty who has taken a test within the last
30 days will be generated. For each student, Training Area will sort the tests. The lock
status, title, test status (needed, passed, or failed), score, date last taken, and number of
attempts will be indicated for each test.

1. Select Reports (menu bar).

2. Select Tests - Last 30 Days.
Report Options screen displays with the option all tests that have been taken
between the dates (30 days before) and (present date) filled in and selected.
3. Select Print Report.
Print Preview screen displays.
4. Select printer icon in tool bar.
5. Select Print Range. (The default is all pages.)
6. Input number of copies. (The default is 1.)
7. Select OK.
Important Note: Depending upon the number of students you have enrolled, it may
take several minutes to generate the report before it displays on the Print Preview
screen.
38. HOW TO CHOOSE THE SPECIALTY COMPLETION REPORT & PRINT
This is one of the report options in the Report pull-down menu. If you make no changes
to the limited Report Options screen that displays after you make this selection, a report
is generated listing all students alphabetically. Beneath each student is listed the
student's specialty and the percentage of tests within that specialty that the student has
mastered. Below each specialty is listed the percentage completion for each of the
training areas within that specialty.
1. Select Reports (menu bar).
2. Select Specialty Completion Report.
A Report Options screen displays.

To limit the report to only students who have completed more than a certain percentage
of their specialty, enter the percentage in the appropriate blank.

The default report covers All Specialties and All Training Areas. You may select a
specific specialty or training area to limit the report.

The default report will print each student's completion percentage as of 30 days ago, as

well as their current completion percentage. To not print the percentage from 30 days
ago, uncheck the "30 Day Progress Report" box.
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Note: Un-checking the "30 Day Progress Report" box will speed up the generation of
the report.
To print the training area break down for each specialty, check the "Display percentage
completion for Training Area(s)" box.
If you do not want to have the Social Security Number of each student displayed, click
the "Display Social Security Number" box.
3. Select Print Report.
Print Preview screen displays.
4. Select printer icon in tool bar.
5. Select Print Range. (The default is all pages.)
6. Input number of copies. (The default is 1.)
7. Select OK.
Important Note: Depending upon the number of students you have enrolled, it may
take several minutes to generate the report before it displays on the Print Preview
screen.
39. HOW TO CHOOSE THE CUSTOM OPTION & PRINT REPORTS
This is one of the report options in the Report pull-down menu. Use this report option if
you want to generate a report covering more than one student. For example, if you
want a list of any student who has taken a specific test or you want a report on the test
status for each student enrolled and you want the students listed alphabetically.
1. Select Reports (menu bar).
2. Select Custom.
The Report Options screen displays.
3. Make the needed selections to customize your report.
4. Select Print Report.
Print Preview screen displays.
5. Select printer icon in tool bar.

6. Select Print Range. (The default is all pages.)

Input number of copies. (The defaultis 1.)
Select OK.

© N
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Important Note: Depending upon the number of students you have enrolled, it may
take several minutes (possibly hours) to generate the report before it displays on the
Print Preview screen. The more you filter and limit the report, the faster the report will be
generated.

40. REPORT OPTIONS

The Report Options screen allows you to make selections that determine what the report
will contain and look like. Once these selections are made, the report output will display
on the screen during Print Preview with the option of printing a hard copy.

The following Report Restrictions are offered:

* Specialty (All Specialties is the default.)
® Training Area (All Training Areas is the default.)

The Specialty and Training areas can be changed to meet your specific need(s) by
making a selection from the drop-down menu available for each of these options.

To specify the organization of the report output, you:

* Select Organize Report.

The Report Organization determines how the student test data is arranged in the report.
The following six options are available for organizing your report:

(1) Specialty
Student (alphabetic)
Training Area
Test (by number or by date)

(2) Student (alphabetic)
Specialty
Training Area
Test (by number or by date)

(3) Specialty
Training Area
Test (by number)
Student (alphabetically, date, or score)

(4) Test (by number)
Specialty
Training Area
Student (alphabetically, date, or score)

(5) Test (by number)
Student (alphabetically, date, or score)
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(6) Student (alphabetic)
Test (by number or by date)

The default is option number 1. The Student or Test options, when available, are made
by clicking on the associated option buttons in the Order Students and Order Tests
dialog boxes at the bottom of the Report Organization screen.

To specify which fields you wish to appear on the report, you:

* Select Field Options.

All the fields displayed on the Student Record are selected as defaults in the Field
Options dialog box. These include:

* Social Security Number

* Lock Status (Lock or Unlock)

* TestTitle

* Test Status (Needed, Passed, and Failed)
* Test Score

* Date Test Last Taken

* Number of Attempts at Test
If you do not want a field included on the report, you deselect it by clicking on the check
box.

Besides these six fields there is also a Social Security Number check box. Select this
check box if you want the students' Social Security Numbers displayed on the report.

To filter and limit the tests displayed on the report, select one or more of the following
options:

* Asingle test

* All tests that have been taken:
- With a score between two percentages
- With a specific number of attempts or more
- Between two specific dates

* Only tests that have been:
- Passed
- Failed

* Only tests that are:
- Unlocked
- Locked

41. HOW TO DOWNLOAD STATISTICAL DATA

49



To download Statistical Data:

. Open the Statistical Data Utilities.

Highlight the type of data (DoD Wide Data) you want to download.
Select Download Data.

The “Copy Statistical Data To” screen displays.

. Select the drive from the Drives drop-down list box.

Select the Directory.

Accept the default in the File Name test box as each file is assigned a unique
name so the CerTest System will not allow you to download the file under any
other name.

Select OK.

Click on OK in the Download Complete! Information box when it displays.

You are then returned to the Statistical Data Utilities screen.

42. HOW TO BACK UP THE CERTEST SYSTEM

Backing up the CerTest system ensures having a copy of CerTest with all tests and
student records in the event that your computer crashes or that your network or hard
drive becomes corrupted. The system should be backed up at least once a week, more
often if there are frequent changes in tests or student records.

1.

2.

1.

Select:

Select Backup CerTest System from the File menu.

Select the type of CerTest Backup you wish to make:

* Site Specific Backup - This is the recommended backup type. This option
makes a backup of all student data, current statistical data, managers, and
site-specific tests and graphics.

* Site Specific Backup - No Tests - Use this option when there are site
specific tests in the CerTest system and they have already been backed-up
(copied) to diskette.

On the Backup CerTest System To screen:

The target drive from the Drives drop-down list box
The Directory
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Note: You may not change the file name of the backup file:

* Site Specific Backups must be named CTBACKUP.001

4. Select OK.

5. If necessary, respond to any information boxes that appear.
6. Select OK in the Backup Complete box.

Additional Information:

To restore from the backup diskettes you've created, select Restore CerTest System.

In addition to the backup file, CerTest creates a text file that contains the date of the
backup, the name of the Site and Station from which the backup was made, and the
CerTest version number. For Site Specific Backups, this file is named CTBACKUP.TXT.

The Backup CerTest option does NOT backup archived statistical data.
Helpful Hints:

* |If you are backing up the system onto disks, be sure to have several high-
density disks ready to store the backup files.

* |If you are running CerTest on a network, you may not need to use the
Backup CerTest option. Check with your network administrator about how
your network is backed up. Networks often have a tape backup system. If
your network is frequently backed up, you should not need to use the
Backup CerTest option.

43. HOW TO RESTORE THE CERTEST SYSTEM

In the event that your computer crashes or that your network or hard drive becomes
corrupted, you may need to reinstall the CerTest system records from a backup copy
made using the Backup CerTest function.

Note: Any student activity that takes place after the backup copy was made will be lost
if the system is restored.
To restore the CerTest system from a backup made using the Site Specific Backup
option or the Site Specific Backup - No Tests option:

1. Reinstall CerTest using the original installation CD (or disks).

2. Reinstall any CerTest update diskettes that you have received since the

original installation CD. Be sure to install them in the order they were received
(check the dates and/or version numbers)

3. Start CerTest.
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4. If the backup was made using the Site Specific Backup - No Tests option and
there were site specific tests copied to diskette, copy these tests back into
CerTest from diskette using the Copy From Diskette option.

5. Select Restore CerTest System from the File menu.

6. On the Restore CerTest System From screen:

* The drive that contains the first backup diskette from the Drives drop-down list
box

* The Directory

7. Select OK.

8. If necessary, respond to any Information boxes that appear. The restore
process may take several minutes or longer.

9. Select OK in the Restore Complete box.
44. HOW TO COMPACT A DATABASE

When you delete a student or a test from CerTest, the Database does not get any
smaller. A "hole" remains in the database where the student or test used to be.

If you have deleted many students, due to PCS, retiring, retraining, etc, you may wish to
remove these holes by compacting the database. This makes the Database smaller so
that it takes up less space on your Hard Drive.

Warning: Always use Backup CerTest System before using Compact. If an error
occurs while compacting, your CerTest system may no longer be usable and you will
have to use Restore CerTest System to restore from your most recent Backup.

1. Select Compact Database (File pull-down menu.)
A message box appears giving the size of the CerTest database.

2. Select OK

Additional Information: If you have not deleted many students or tests, Compact will not
significantly reduce the size of the database.

Note: If you are running on a network, you must be the only user logged on to
CerTest in order to use the Compact Database option.
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45. HOW TO REPAIR A DATABASE

If there is a power failure or the computer is turned off while CerTest is writing data to
the Database, the database may become corrupted. If this happens, the CerTest
system will behave strangely and frequent errors will occur. Using Repair Database may
fix this kind of a problem. Sometimes the database may be so corrupted as to render it
unrecoverable. In this case you must use Restore CerTest System to restore from a
previous Backup.

Warning: Always use Backup CerTest System before using Repair Database. If an
error occurs while repairing, your CerTest system may no longer be usable and you will
have to use Restore CerTest System to restore from your most recent Backup.

To repair the CerTest database:

Select Repair Database (File pull-down menu.)

Note: If you are running on a network, you must be the only user logged on to CerTest
in order to use the Repair Database option.

46. CHALLENGING QUESTIONS

What is a Question Challenge?

While taking a test, a student may find a question that he/she believes to be erroneous
or invalid for some reason (i.e., typo, spelling mistake, missing graphic, ambiguous
question, etc.).

Challenging Questions:

1. Click the hand icon on the toolbar, or by select “Challenge This Question”
from the Help menu.

2. Type a short but clear description of the error.
NOTE: “This is a bad question” is not good rationale.

You may also view, print, download, or delete some or all of these Question
Challenges.

View Question Challenges:
1. Select File (menu bar).

2. Select Print/Download Question Challenges. The Print/Download
Question Challenges window appears.

NOTE: You may restrict the Question Challenges that you print, download or delete by
selecting a date range and/or test number range. If you do not select a date
range or test number range, all Question Challenges in the Question Challenge
database will be printed, downloaded, or deleted.
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Printing Question Challenges:

1. Select Print/Download Question Challenges from the File Menu.

2. Enter a date range and/or test number range to restrict the number of
challenges you print.

3. Click the Print button.

4, Click the printer icon button to send the challenges to the printer; or, use
the other buttons on the toolbar to browse the challenges on screen.

Downloading Question Challenges to Disk:
1. Select Print/Download Question Challenges from the File Menu.

2. Enter a date range and/or test number range to restrict the number of
challenges you download to the text file.

3. Click the Download to Disk button.

4, Select a name for the text file and a path to where you would like it to be
saved, then click OK.

NOTE: The default file name is CHALLENG.TXT. If the file already exists, you will be
asked if you would like to append the Question Challenges to the end of the existing file.

Deleting Question Challenges From the Database:
Once you have printed and/or downloaded the Question Challenges and reported the

valid ones to the CerTest point of contact specified in your Procedural Guide, you may
wish to remove them from the database.

1. Select Print/Download Question Challenges from the File Menu.
2. Enter a date range and/or test number range to restrict the number of challenges
you delete.

3. Click the Delete button.

You will be prompted to confirm that you wish to permanently delete the
challenges from the database.

4. Click Yes.
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